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Microsoft® Office Specialist 2016 Series 
 
 

Microsoft®
 

Access 2016 
Certification Guide 

Lesson 1: Exploring the Access 
Environment 
Lesson Objectives 
In this lesson, you will explore the Access interface and learn to create, open, and save database files. You will 
also work with the Navigation Pane and export database data. Upon successful completion of this lesson, you 
should be able to: 

 describe the function of a database 

 identify database objects 

 differentiate between Access web app 
databases and desktop databases 

 identify the main components of the Access 
user interface 

 identify screen elements 

 start Access and create databases  

 import database objects 

 open and close databases 

 work with the Navigation Pane 

 save a database as a template 

 export objects to alternate formats 

 set Access options 

  FO
R EV

ALU
ATIO

N O
NLY



Lesson 1 Exploring the Access Environment 
 

 

2  3265-1 v1.00 © CCI Learning Solutions Inc. 

An Introduction to Databases 
Although many people become uncomfortable at the thought of working with a database, a database is 
nothing more than an organized collection of information. The basic function of a database is to store data. 
If the database is well organized, retrieving the data you want is easy, and you can then generate reports, or 
lists, and analyze the data in ways that are meaningful. 

The key to designing and using a database successfully lies in understanding the nature of the data – that is, 
how the pieces of information are related to each other – and understanding how Access stores and 
manipulates the data. 

Spreadsheet Databases 
Many users are comfortable with spreadsheets, and many databases begin as an Excel worksheet. 
Spreadsheets display rows and columns of data in a table format. It is easy to understand and visualize the 
data in a spreadsheet because all the data is visible and stored in one location.  

A database in Excel is a single table that cannot include any blank rows or columns.  

Consider the scenario of a gardening supply store that needs to track orders. A spreadsheet database solution 
created in Microsoft Excel 2016 might appear as shown in Figure 1-1. 

 
Figure 1-1: Spreadsheet database solution for gardening supply store 

Although it is easy to see and understand the data shown in the spreadsheet, notice that there is considerable 
repetition in the table.  In this database, a single order requires a record for every line item. This type of 
database will take longer and longer to search as it grows. 

Also, the person entering the order information must type in the same information (order number, customer 
number, customer name and customer address) many times for a multiple-item order. This is a time-
consuming process, and presents many possibilities for error. 

The large size and repetitive nature of the data reflect the complexities of the data itself. At first thought, 
tracking orders might seem a simple task; but consider how the various pieces of data are related: A customer 
may place one or more orders, each order will consist of one or more line items, and each line item must 
reflect a product that is available in inventory. These relationships are quite complex.  
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Relational Database Management Systems (RDBMS) 
A database application, on the other hand, is designed to handle complex relationships among various items 
of data, and is correctly referred to as a relational database management system (RDBMS).  A RDBMS allows 
you to define, create and maintain databases while providing controlled access to the data.  

Many database applications are available on the market. Oracle, SQL Server, MySQL and Microsoft Access 
are just a few. These programs offer various features and interfaces, but all of them access stored data in a 
standard manner – through Structured Query Language (SQL). 

Structured Query Language (SQL) 
Structured Query Language (SQL) is the standard language used to create and work with databases. Once a 
database has been created, SQL is also used to retrieve and manipulate the data. Any interaction among a 
user, program and database takes place using SQL. 

Even though various RDBMS applications provide their own user interface, SQL is used (often behind the 
scenes) to create and manage both the database elements themselves and their data. 

Multiple, Related Tables 
Unlike spreadsheet databases which store all the information in a single table, relational databases store data 
in multiple tables which are related to one another. In fact, one of the first things you may notice when you 
open and examine a database table is that you are viewing only part of the data. That is because the data is 
parsed out into several related tables. 

Let’s consider a database solution for tracking the activities of a gardening supply company. Each table in a 
database stores data about a specific aspect of the information. There might be a table that contains 
customer information, a table that contains order information, a table that contains detail in formation for 
each order, and a table that contains product information. 

Because the data stored in each table is related to data in other tables of the database, a complete set of 
information can be retrieved. For example, you could retrieve the complete set of information for any given 
order, as shown in Figure 1-2. 

 
Figure 1-2: Information for one order 
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This complete set of information is extracted from the Customers, Orders, OrderItems and InventoryItems 
tables, as shown in Figure 1-3. 

 
Figure 1-3: Related tables from which a complete set of information is retrieved 

The shaded rows in the figure show that Order #1 was placed by Helen Anderson (Customer #1012) on 
2/19/2015. The order includes three line items: one for fieldstones for a garden path (item #40), one for 2 
garden hoses (item #45), and one for some rosemary seed (item #17). 

Note that each table in the database stores data about a specific type of thing. For example, the Customers 
table stores information only about customers; it does not include information about orders or inventory. In 
database terminology, the specific type of thing for which data is stored is called an entity. Usually, there is 
a table for each entity represented in the database. 

Using separate tables is very efficient. Notice that in contrast to the spreadsheet solution, very little data is 
repeated among the tables. Minimizing the repetition of data helps to keep data valid and accurate. 

Even if you are new to databases and they seem a little scary, once you become accustomed to how data is 
stored and presented, you will find they are an easy solution for storing complex data. 

What is Access? 
Microsoft Access 2016 is a RDBMS and a complete application development environment. Unlike other 
RDBMS’s, Access includes tools to help you develop user-friendly interfaces and reports. Even if you are 
interested only in setting up databases and managing data, Access provides a user-friendly environment that 
allows you to accomplish database tasks very quickly even without prior database knowledge. 
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As you learned earlier, any interaction among a user, program and database takes place using SQL. In Access, 
the actual SQL code that controls and manipulates the data is used behind the scenes; you never see the SQL 
code (unless you want to). Instead, you interact with a graphical environment which allows you to create 
tables, queries, reports and other database objects. 

Access Database Files 
An Access database is a container for a variety of database objects; it can contain as few as a single table, or 
a large collection of tables, forms, reports and queries. For example, an order tracking system (such as the 
one discussed earlier) that uses four tables is not four databases; it is one database that includes four tables: 
one for customer information, one for order information, one for order detail information and one for product 
information. 

An Access 2016 database stores its objects in a single file with the .accdb file name extension. (Access 2007-
2013 also uses the .accdb file name extension.) Databases created in earlier versions of Access use the .mdb 
file name extension. 

Database Objects 
An Access database can contain various types of database objects, including tables, queries, forms, reports, 
macros and modules. These database objects are briefly introduced here. Individual types of database objects 
will be discussed in detail in later lessons. 

• Tables – are the database objects used to store data. 

• Forms – are user-friendly interfaces for working with the data stored in a database’s tables. Forms are 
commonly used as data entry screens  

• Queries – are questions you ask about the data. They are used to extract subsets of data from one or 
more tables in the database. 

• Reports – are printed output that you generate to summarize and share your data with others. 

• Macros – are a series of database actions that are saved as an executable block of simplified 
programming language database. They are used to add simple automation to a database. 

• Modules – are collections of declarations, statements and procedures stored together as a unit of code 
written in the Visual Basic for Applications (VBA) programming language. Modules execute procedures 
that run complex and intelligent time-saving automated operations in a database. 

Note: This course introduces basic and intermediate skills for Access 2016. Not all the database objects 
listed above are covered in this course. 

Access Web App Databases and Desktop Databases 
There are two types of databases you can create in Access – Access web app databases, and Access desktop 
databases. The type you use determines the way in which you interact with the data and share it with others. 

An Access web app database is one that is stored on a Microsoft SharePoint or Office 365 server and accessed 
by users via a web browser. The web app database is created and customized within Access; however, all user 
interactions with the data take place in the web browser.  
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Web app databases are easily created using a template. Select a template for the type of data you want to 
track (for example contacts, tasks, or projects), and Access creates the database structure for you, including 
views, navigation and basic commands. You can then add and edit data through your browser. 

In contrast, an Access desktop database is one that you work with on your local system. The database itself 
may be located on your local hard drive, or a stored on a centralized database server and accessed over your 
organization’s network. You interact with the data through the Access application (not through a web 
browser).  

In this course, you will work with desktop databases.  

Components of the Access User Interface  
The Microsoft Access 2016 user interface provides the ability to work with a database as a complete file, and 
the ability to work with individual objects within the database. The three main components of the Access 
2016 user interface are: 

• Ribbon – A panel of command buttons and icons organized into sets of tabs. The Ribbon appears across 
the top of the program window. Each tab on the ribbon contains groups of commands related to specific 
database tasks. 

• Navigation Pane – A pane on the left side of the program window that displays database objects 

• Backstage view – A collection of options on the File tab of the Ribbon. 

The Ribbon 
The Ribbon is a tabbed toolbar that contains the commands and options you use to perform tasks. 
Commands are grouped on tabs with each tab relating to a type of activity, such as creating database objects, 
working with external data, or using database tools. You can customize the Ribbon to display those 
commands you use most often), or to add or remove commands from a ribbon tab (not covered in this 
course). 

The Access 2016 Ribbon is shown in Figure 1-4 with the Home tab selected. 

 
Figure 1-4: The Ribbon  

The Ribbon includes the following components: 

• Ribbon tabs  – Relate to a type of activity, such as creating objects in a database, or working with external 
data. Each tab on the Ribbon is organized into groups of related commands. For example, the Home tab 
includes a group called Text Formatting, which contains buttons for formatting text characters; and the 
Database Tools tab includes a group with different analysis tools that can be used to analyze tables and 
performance. 
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• Command buttons  – Appear on the ribbon tabs in groups. When you click a command button, an 
action occurs. For example, when you click the Relationships command button, the Relationships 
window appears. 

• Collapse the Ribbon button  (CTRL+F1) – Collapses the Ribbon to just the tab names to conserve 
space on the screen. You can still use the Ribbon while it is collapsed – simply click a tab name to expand 
the Ribbon when you need to perform a task. The Ribbon will automatically collapse again once you 
have clicked a button.  You can also press CTRL+F1 to toggle between a collapsed and expanded Ribbon. 

• Microsoft Access Help (F1) button   – Provides access to information and tips about the program’s 
features. You can type in keywords in the Search field to display Help topics about which you want to 
learn more. 

To reduce screen clutter, contextual ribbons (such as Table Tools, Query Tools, or Form Layout Tools) appear 
only when they are appropriate for the task at hand. Figure 1-5 shows the Table Tools ribbon, which contains 
two tabs (Fields and Table); this ribbon appears only when a table is open. 

 
Figure 1-5: Table Tools contextual ribbon 

A button that appears in a different color or that displays an outline is active. Many buttons are 
toggle buttons; that is, they deactivate when you click the same button again. For instance, you 
can apply italics to selected text by clicking the Italic button. While the command is active, the Italic button 
has a different color and outline. To turn off the italics, click the button again. 

You can click the dialog box launcher  button  at the lower right of a group to display a dialog box, window, 
or task pane offering more options for this group of features. Figure 1-6 shows the Datasheet Formatting 
dialog box and the Clipboard task pane. 

   
Figure 1-6: Dialog box and task pane 
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Using a dialog box, you can change options for the selected feature, click a button to apply the changes, 
then close the dialog box. However, a task pane remains open on the screen so you can make ongoing 
changes; for example, the Office Clipboard task pane shows items that have been cut or copied to the 
clipboard and are available for pasting into one or more database objects. 

If a group shows a feature with drop-down arrow, you 
can click the drop-down arrow to display a list or a 
gallery of options for that feature. 

The Application Parts drop-down arrow and gallery 
are shown in Figure 1-7. 

 

 
Figure 1-7: Application Parts gallery 

The Navigation Pane 
Located on the left side of the 
screen, the Navigation Pane is a 
central location from which you 
can create and use any type of 
database object.  

The Navigation Pane is shown in 
Figure 1-8. 

When you open a database, the 
Navigation Pane is displayed to 
the left of any open database 
objects in the work area. 

 
Figure 1-8: Navigation Pane 

The Navigation Pane includes the following components: 

• Navigation Pane menu – Click the drop-down arrow to open a menu that allows you to specify which 
objects to show. The default selection is All Access Objects. 

• Open/Close buttons – Collapses the Navigation Pane so only its Open/Close button and shutter bar 
display. Collapsing the pane provides more space on the screen for working with an object. To reopen 
the Navigation Pane, click its shutter bar. 

• Object groups – Organizes the objects in a database, allowing you to find what you are looking for. Each 
object group includes an Open/Close button, which you can use to collapse or expand the list. 
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• Database objects – The tables, queries, forms and other objects that exist in the database. By default, 
each object appears in its appropriate group.  

• Search box – You can type the name of an object for which you are looking and the objects that display 
in the Navigation Pane are filtered to match the name you enter. 

The Navigation Pane shown in Figure 1-8 shows all the objects in the database and does not display empty 
object groups. That is, the Macros and Modules groups do not appear in the Navigation Pane because the 
database does not contain any of these objects. 

To open an object, double-click it in the Navigation Pane. You can also right-click an object to display a 
shortcut menu. For example, you can right-click a table and specify to open it in Design view. You will work 
with the Navigation Pane later in this lesson. 

Backstage View 
You use Backstage view (shown in Figure 1-9) to create, open, save, print and manage databases. The 
commands and options available here are related to things you can do with the database itself. For example, 
you can create or open a database, encrypt it, assign a password, or repair and compact it. To access 
Backstage view, click the File tab on the Ribbon. 

In contrast to Backstage view is the Ribbon view (sometimes called the fluent user interface), which you use 
to work with the objects within a database. For example, you use the Ribbon view to create tables, add 
records, or modify a form. The Ribbon view is displayed using any Ribbon tab other than the File tab. 

 
Figure 1-9: Access 2016 Backstage view – Info tab 

The tabs/commands that appear in the left panel in Backstage view are: 

• Info – Use this tab to repair and compact a database, and to encrypt a database with a password. (If you 
are working with an app, use this tab to manage connections and create reports from online data. 

• New – Use this tab to create a new database or Access app. 
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• Open – Use this tab to view locations where you have stored files, including cloud locations. 

• Save – Use this command to save any changes to the database. 

• Save As – Use this tab to select file formats, save specific database objects, or save a database to 
SharePoint. 

• Print – Use this tab to print records, forms, reports and so on. 

• Close – Use this command to close the open database, but leave Access open. 

• Account – Use this tab to connect services and storage locations to your Office account, update your 
profile, change your photo or sign out. 

• Options – Use this command to open the Access Options dialog box (which you will explore later in this 
lesson). 

• Feedback – Click this tab to access the Microsoft Feedback Hub, where you can provide feedback on 
Microsoft products. 

Note: Access can also be configured to display quick links to the four (can be set to up to 25) most recently 
used database files below the Feedback tab in Backstage view. 

To return to the Ribbon view, click the  (Back) button at the top of the left panel. 

Looking at the Screen 
In addition to the Ribbon, the Navigation Pane, and Backstage view, several other components appear on 
the screen at various times as you work in an Access database. Many of these components are shown in 
Figure 1-10. 

 
Figure 1-10: The Access application window 
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